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FMnotes – enhance, convert
footnotes, insert sidenote
Overview
This set of scripts enhances footnotes with a hyper
link. Footnotes can be converted to end-notes and
the insertion of side-notes is automated.
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Introduction
Why this set of scripts?

 With the experience from the Web we expect references to
be links. Hence footnote references should be hypertext.
This could also leverage the (FM) problem of references to
footnotes on the next page. The hypertext would greatly
enhance the value of footnotes in PDFs and of course also
in FM when in zoomed view…1) or in longer tables where
the footnotes are most of the time on another page.
 There should be a commonly known shortcut for the Go
Back function.
 My scholarly friends have asked me often for a mechanism
to convert footnotes to endnotes. In a single document
they should be collected at the end under a specific heading. In a book these should be collected in an own chapter
document.
 I would like to see a template mechanism to insert side
notes. This should create an anchored frame (outside of
text frame) with a text frame in it at the ‘current location’.

Installation

1 Download the ZIP from the website and expand it to a location of your liking.
2 Execute the file PrepareInstallation.exe.
3 The language of the installation dialogues adapts to the UI
language of your current FM installation (de, en, fr).
4 This program modifies some values in the file
InstallThis\config.ini.
5 Use Continue Installation. This opens the installation program.
6 Select the appropriate option(s):
-

Use the first option to start the script automatically at
FM-start.
Use the second option if you wish to start the script on
demand from a trusted source. You can define the script
in File > Scripts … > Cataloge (Script Library) as
Favourite: use the Add button and navigate to My
Documents\Adobe Scripts\FMNotes\FMnotes.jsx.

7 With Install the script and associated files will be transferred into the relevant locations.
8 A message indicates the end of the installation. The desktop icons will be removed.

Predefined values

Some global variables need to be adapted to the user environment. In particular these are formats for paragraphs, characters and cross references. See Adaptation of global variables on
page 11.

French localisation

Traduction française avec l'aide de https://www.deepl.com/
translator.
1

Well, unfortunately the Go Back function does not go back to the point
where we left, but only to the top of that page. And cross-documents it
does not work at all...
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Script invocation
Menu entries

The menu is inserted in the Format menu, because this is also
available when a book is active.
Unfortunately ExtendScript does not allow to define a position for the menu – it always appears at the end of the parent
menu item (Format) — bug FRMAKER-2752 .
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Document menu
Format

Shortcut

Footnotes and Endnotes v1.0 Documentation

ESC q n d

Enhance Footnotes

See

ESC q n f page 4

Convert to Endnotes

ESC q n e page 6

Insert Endnote

ESC q n i page 9

Back to Insert Point

ESC q n b page 9

Insert Sidenote

ESC q n s page 10

Book menu
Format

Shortcut

No UnDo of script operations

ESC q n d

Enhance Footnotes

ESC q n f page 4

Convert to Endnotes

ESC q n e page 6

It is too complicated to provide an UnDo for script operations.
Hence none of the D+DD scripts save changed documents.
In case of an error or change of Your mind you can simply
Revert to Saved for the pertinent document.
All function of FMnotes may create paragraph formats, character formats or cross-reference formats. These are of course
lost if you revert to saved.

Documentation

This pdf is displayed with your PDF viewer.

D

E:\_DDDprojects\FM-Notes\Docu\FMnotes.fm

Footnotes and Endnotes v1.0 Documentation

See
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Enhance footnotes
Note:

Enhance Footnotes acts on all footnotes, that is also on table footnotes and footnotes in text frames which are in an anchored
frame.

Invoking the script

Start the script by Format > Footnotes and Endnotes > Enhance
Footnotes or ESC q n f.

Prerequisites

This function requires a set of formats:
 Cross reference format zfnref‐footnote‐reference
 Character format super
 Character format hypertext
If such a format does not exist in the document when Enhance
Footnotes is used in a document, then these formats are created. You get an according message.
Created ¶ formats are based on the Body format.
If you want to change the format names and string definitions, you should not do that just in the document. Change it
in the global definitions before you first run Convert to
Endnotes.
See Adaptation of global variables on page 11.

Function of this script

 The footnote references of a document are collected in an
array and then they are worked off from back to front…2) .
 At the beginning of a footnote a cross reference marker is
inserted.

 Just before the footnote reference a cross reference to the
footnote is inserted.

 The cross reference format zfnref‐footnote‐reference
does not contain any variable text as with ordinary cross
references. It just gives some space for the sensitive area
(hotspot): <super>…
 The hypertext function is indicated by the character format
hypertext (blue text) and is applied to the whole construct.
2

This is to keep the locations intact for all but the currently handled footnote reference.
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 The footnote reference itself is not touched by this mechanism. It does not show the hypertext property, although
the character format is applied to the whole construct.
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Shortcut for Go Back

Although there is an escape sequence (ESC v P) to come back
from a cross reference users want to use the same short cuts
as known from PDF, the web etc.: ALT+< and ALT+8. This however would make it impossible to nudge objects by 1 pixel.
Hence I decided to use ESC < and ESC 8 for the back- and forward jumps.

Avoid footnote and reference
on different pages

With the cross reference to the footnote this requirement
became less important. The major drawback of the footnote
on the following page is minimised by the link and possibility
of Go Back by the installed short cut.

E:\_DDDprojects\FM-Notes\Docu\FMnotes.fm

Update document
After applying the cross references to the footnotes it is common that a document update will receive additional footnotes.
Just run FMnotes > Enhance Footnotes again.

Starting in book
When a book is active and FMnotes > Enhance Footnotes is run,
then all FM files (except generated ones such as TOC, Index)
are handled.

Special cases
In documents like this one where footnote mechanisms are
explained, Enhance Footnotes may create some unwanted
results: inserting a cross reference where it should not.

D

In this case You need to remove the inserted cross reference
and the corresponding marker:
 Removing the cross reference in front of the footnote reference also removed the marker in the footnote.
 You may want to set the footnote reference to its default
appearance by applying character format Default ¶ Format.
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Convert Footnotes to Endnotes
Note:

Convert to Endnotes acts only on ordinary footnotes, not on table
footnotes and footnotes in text frames which are in an
anchored frame.

Shortcut for Go Back

Although there is an escape sequence (ESC v P) to come back
from a cross reference users want to use the same short cut
as known from PDF, the web etc.: ALT+<. FMnotes implements
this.

Invoking the script

Start the script by Format > Footnotes and Endnotes > Convert to
Endnotes or ESC q n e.

Prerequisites

This function requires a set of formats:
 Paragraph formats zent‐endnote‐title, zen‐endnote and
zenc‐endnote‐continue.
 Cross reference format zenref‐endnote‐reference
 Character format super
 Character format hypertext
If such a format does not exist in the document when Convert
to Endnotes is used in a document, then these formats are created. You get an according message.
Created ¶ formats are based on the Body format.
If you want to change the format names and string definitions, you should not do that just in the document. Change it
in the global definitions before you first run Convert to
Endnotes.
See Adaptation of global variables on page 11.

Function of this script

 The standard footnotes of the document are collected in an
array with their local formatting.
 At the end of the document a title paragraph is inserted.
 After this title all footnotes are now inserted getting a new
paragraph format with autonumber.
 At the original places of the footnote references cross references to the now endnotes are inserted. The local character formatting is preserved.

Update document with endnotes
After converting the footnotes to endnotes do not use the original footnote mechanism any more, but the menu item Insert
Endnote. See Insert Endnote on page 9.

Starting in book
When a book is active and FMnotes > Convert to Endnotes is run,
then all FM files (except generated ones such as TOC, Index)
are handled.
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Convert Footnotes to Endnotes

After collecting the relevant footnotes in an array a new document is created, named Endnotes.fm.

D

E:\_DDDprojects\FM-Notes\Docu\FMnotes.fm
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Note:

Whether the numbering of footnotes in the book start anew in
each file or are numbered continuously has no influence on the
collection for the endnotes. These are always number continuously.
A title paragraph is inserted and after this the footnotes are
placed with a new paragraph format. The local character formatting is preserved.

Example footnotes

Example endnotes

From the example footnotes the following endnotes will be
created:

References to endnotes

Depending on the specification for the footnote references
you may not see much difference after processing. The only
recognisable difference is the hypertext feature of the new
references - they are ordinary cross references. These change
the cursor image to a hand symbol when hovering over while
pressing the ALT + CTRL keys.
To get a larger hotspot for the hypertext function, the cross
reference format uses two required blanks before and after
the reference figure.
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Formatting
FMnotes creates only the functional necessary formatting, if
no corresponding ¶ formats are provided in the document.
Created ¶ formats are based on the Body format.
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Insert Endnote
After converting the footnotes to endnotes the user must not
use the original footnote mechanism any more…3) , but the
menu item Insert Endnote.
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Note:

Inserting Endnotes requires that there is at least one cross reference to an existing endnote. This cross reference is required
to determine whether the endnotes are in the same file or in a
separate file.

Inserting an endnote

1 Set the insertion point where the endnote reference shall
appear (similar to inserting a footnote).
2 Start the script by Format > Footnotes and Endnotes > Insert
Endnote or ESC q n i.

Invoking the script

4 At the place where the reference shall appear (the user’s
location of step 1) a cross reference with the appropriate
format is inserted.
5 The script then jumps to the empty endnote and places the
cursor behind the marker.
6 You can now type the new endnote.

Back to insert point
After typing the endnote text at the provided location you
may want to verify the location where you started the insert.
Use menu Back to Insert Point or ESC q n b to go to that point…4).

Invoking the script

You will get an open dialogue Update References.
 If you are working on a single file (not part of a book) just
cancel this dialogue (References are updated already).
 If you are working on a book file, select the topmost check
box (All Cross References) and use button Update.…5)

D

E:\_DDDprojects\FM-Notes\Docu\FMnotes.fm

3 The script determines the ‘location’ among the existing
endnotes, inserts a new empty note and places a cross-reference marker.

3
4
5

Of course common footnotes can serve as a separate apparatus.
The standard command Go to previous View (ESC v P) does not work for
an XRef inserted by a script. It works of course, if you use the inserted
XRef by ALT+click on it.
ExtendScript function UpdateXRefs does not update XRefs in book files!
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Insert Sidenote
What is a sidenote?

According to my reference H. Hiller, Wörterbuch des Buches, 4th
ed. Frankfurt am Main: Klostermann, 1980:
Marginal notes at the outer margin of the individual pages of
a book, especially in the case of scientific works. In the manner of running titles, they are intended to indicate the content
of individual text passages, paragraphs or pages.

Prerequisites

This function requires a set of formats:

This is a side
note with format zsn-sidenote.
The font is
the same as
from tl-tableleft, but font
size is 8pt.

 Paragraph format zsn‐side‐note
 Colour for filling the side note text frame. This must be a
user defined colour (standard colour names are localised
and thus create problems).
If such a format does not exist in the document when Insert
Sidenote is used in a document, then these formats are created.
You get an according message.
A created ¶ format is based on the Body format and gets size 8pt.
If you want to change the format names and string definitions, you should not do that just in the document. Change it
in the global definitions before you first run Insert Sidenote.
See Adaptation of global variables on page 11.

Inserting a sidenote
Invoking the script

1 Set the insertion point where the sidenote shall be
anchored.
2 Start the script by Format > Footnotes and Endnotes > Insert
Siednote or ESC q n s.
3 At the current location an anchored frame of type Outside
Text Frame is inserted. Default height is 4cm.
4 The location of the frame is determined:
-

From the global setting specifying which side
From the available space in the margins.

5 Within the anchored frame a text frame is established. It
may be filled with a user defined colour.
6 The properties of the anchored frame are taken from
global settings. SeeAdaptation of global variables on page 11

Modify appearance

It is your turn to adapt the height of the text frame to its contents. More fiddling (e.g. new placement) is necessary for
notes which are placed to low on the page.

Modify appearance

When modifying the width and location of the text frame
locally (not in the master page) these properties are observed
by the script.
Hence you can narrow the text Frame to give more room for
side notes on individual pages. Do so before you insert the
sidenote!

Known issue

The message concerning missing ¶ format zsn‐side‐note may
appear twice, even if you write something into the first note.
47 – 10

This is a side
note has its
anchor in the
very last paragraph of
this page..

Implementation considerations

Implementation considerations
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The script checks for existence of the necessary formats. If
one does not exist in the catalogue, then it is created with the
default names (see the Global variables) and the minimum
required properties.

Adaptation of global variables
Module FMnotes_Globals.jsx define variables which may be
set by the user to adapt to his document environment.
Global value

Purpose

Default

Example user setting

Character format for superscripting

"super"

"sup"

Character format indicating hypertext

"hypertext"

"link"

Enhance footnotes
FmtSuper

a
b

E:\_DDDprojects\FM-Notes\Docu\FMnotes.fm

FmtHypertext

goFno.FmtXRefName

Name of the cross-reference format of "zfnref‐footnote‐
the hypertext to the footnote
reference"

"footnote‐ref"

goFno.FmtXRefContents

Contents of the cross reference format c "<super>…"

"!!"

Convert footnotes to Endnotes, Insert Endnotes
FmtSuper

d
e

FmtHypertext

goFno.FmtEnTitle
goFno.FmtEn

f

goFno.FmtEnCont

g

goFno.FmtEnRef

Character format for superscripting

"super"

"sup"

Character format indicating hypertext

"hypertext"

"link"

¶ format of title to the endnotes

"zent‐endnote‐title"

"endnote‐title"

¶ format for the endnotes

"zen‐endnote"

"endnote"

¶ format for continue paragraphs (a
footnote may comprise multiple ¶s)

"zenc‐endnote‐continue" "endnote‐cont"

Cross-reference format to the end-note "zenref‐endnote‐

"endnote‐ref"

reference"
goFno.FmtEnRefContents

Contents of the cross reference format "<hypertext><super>\
The required spaces enlarge the hot<$paranumonly>\ "
spot area.

"<super><$paranu
monly>)"

goFno.SideNoteLocation

undefined> in larger margin;
true:
in inner margin;
false:
in outer margin

undefined

false

goFno.FmtSideNote

¶ format for the side note text

"zsn‐side‐note"

"sidenote"

goFno.SideNoteMinWidth

Minium width [cm]

1.6

goFno.SideNoteOffset

Space between text frame / page frame 0.2
and the inserted anchored frame [cm]

D

Insert Sidenotes

goFno.SideNoteHeight
goFno.FmtSideNoteBackGr

Default height of anchored frame [cm] 4.0
h

Background colour in side note area

"frame‐0"

""

a. Required properties: all ASIS + superscripting
b. Required properties: all ASIS + some indication, e.g colour Blue
c. The indicating symbol providing the sensitive area for the hypertext must exist in the paragraph font. Hence there is only limited
choice: ellipsis or underscore.
d. Required properties: all ASIS + superscripting
e. Required properties: all ASIS + some indication, e.g colour Blue
f. Required properties: Similar to Body, with numbering. The numbering (<$paranumonly>) is used for reference.
g. Required properties: no numbering, same indentation as FmtEn.
h. This must be a user defined colour, because standard colours get localised names.
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Cross reference to Footnote
It is not possible to combine the two objects Footnote (Fn) and
Cross reference (XRef) into one. The only possible solution is
to add a cross reference in front or after the footnote reference.

Cross reference

I wanted to have some sort of graphic indication of the hypertext area (a hot spot). But a solution with a special font may
be…6) contra-productive7) .
To avoid a to complicated definition of the cross references
format (requiring a number of character formats) I decided:
 The indicating symbol providing the sensitive area for the
hypertext must exist in the paragraph font.
 Hence there is only limited choice: ellipsis or underscore.
 I decided for the ellipsis, because this is somewhat wider
than the underscore (superscripting scales to 70%).
 The character format for hypertext is applied across both
the cross-reference symbol and the footnote reference.

Cross reference marker

The contents of the cross reference marker must be unique. I
decided to combine two IDs: that of the cross reference and
that of the footnote paragraph, for example
419606586:1351136

Short cut for Go Back

The installation routine adds a line to the menus.cfg file…8), if
ETB (Enhanced Tool Bars) are not already installed:
<Modify GotoPreviousView <KeySequence ~/Left>
<KeySeqLabel Alt+«‐>>.

For this function we need to increase…9) for this paragraph
the Widow/Orphan lines to the number of lines in the paragraph. Then the whole paragraph goes to the next page where
the footnote already is.

Avoid footnote and reference
on different pages

A reasonable procedure would set this value to n with n being
the number of lines in the paragraph up to the line with the
footnote reference.
IMHO this requirement became less important with the hypertext capability and the common Go Back short cut.

6
7
8
9

Just by footnote definitions.
Wingdings n with character formats super and hypertext.
Only UnStructured\WYSIWYGview in the user area is considered.
In most templates this set to about 2.
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Convert Footnotes to Endnotes
There is a 1 by 1 correspondence between footnotes and endnotes. Both can have multiple continuation paragraphs, which
also correspond in number. This becomes recognisable in a
book when the documents restart the footnote numbering.

E:\_DDDprojects\FM-Notes\Docu\FMnotes.fm
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Endnotes in a document
Doc

Procedure overview

Doc, last page

Some text with footnote 1)
Another paragraph with a
footnote 2) .
And here the last para with
footnote 3) .

Endnotes

{

1
2

3

Doc1: this is foontoe one.
Doc1: This footnote
Has multiple paragraphs with
individual format.
Doc1: Last footnote.

1 Doc1: this is footnote one.
2 Doc1: This footnote
Has multiple paragraphs with
individual format.
3 Doc1: Last footnote.

Endnotes in a book

Doc1

3

The endnotes are copied into an own new document named
endnotes.fm. The last FM document in the book is taken as
template. A paragraph endnote‐title is inserted before the
endnotes are copied.

Procedure overview
Doc2

Some text with footnote 1)
Another paragraph with a
footnote 2) .
And here the last para with
footnote 3) .

1
2

D

At the end of the document a paragraph endnote‐title is
inserted. This has normally the property Start on new page.

Doc1: this is footnote one.
Doc1: This footnote

Has multiple paragraphs with
individual format.

Doc1: Last footnote.

Doc3

Some text with footnote 1)
Another paragraph with a
footnote 2) .
And here the last para with
footnote 3) .
Last one 4) .

Some text with footnote1)
Another paragraph with a
footnote 2) .
And here the last para with
footnote 3) .
Last one 4) .

1
2

1
2

3
4

Doc2: this is footnote one.
Doc2: This footnote

Has multiple paragraphs with
individual format.

Doc2: Another footnote.
Doc2: Last footnote.

3
4

Doc3: this is footnote one.
Doc3: This footnote

Has multiple paragraphs with
individual format.

Doc3: Not the last footnote.
Doc3: The very last

Endnotes

{

{
{

1
2

Doc1: this is foontoe one.
Doc1: This footnote
Has multiple paragraphs with
individual format.
3 Doc1: Last footnote.
4 Doc2: this is footnoe one.
5 Doc2: This footnote
Has multiple paragraphs with
individual format.
6 Doc2: Another footnote.
7 Doc2: Last footnote.
8 Doc3: this is footnote one.
9 Doc3: This footnote
Has multiple paragraphs with
individual format.
10 Doc3: Not the last footnote.
11 Doc3: The very last

The a 1 by 1 correspondence between number of footnotes
and endnotes allows to get all necessary information for the
insertion of the endnotes and creation of the cross references
during the collection of the footnotes. This information is
stored in a structure
function oDocProps (oDoc, sName, nFns, jEnFirst, jEnLast) {
this.Doc
= oDoc;
// Document object
this.Name
= sName;
// Document full path
this.FnCount = nFns;
// # foot notes in it
this.ENfirst = jEnFirst;
// # first Endnote
this.ENlast = jEnLast;
// # last Endnote
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The items jEnFirst and jEnLast are indices in ancillary arrays:
aoFNcollected
aoEndNoteTL

Endnotes in a book (or single
document)

// Footnote objects
// Text location Start of EN

The basic procedure is this:
 Save current doc and location.
 Fill the array aoBkDocsCollected with the book components.
(For a single document just one item is stored).
 Create the endnote document with title (or the endnote
title at the end of a single document).
 Loop over the documents in aoBkDocsCollected:
- Open book component.
- Accumulate the footnote object in aoFNcollected.
- Define ENfirst and ENlast in aoBkDocsCollected[j].
- CreateEndnotes using ENfirst and ENlast as loop
bounds.
‐ ReplFnByRefs using ENfirst and ENlast as loop bounds.
 Restore current doc and location.
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Implementation considerations
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